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* INTRODUCTION

In the ever-evolving landscape of cybersecurity, memory forensics has emerged as a pivotal
technique in digital investigations. Unlike traditional disk forensics, which focuses on analyzing
static data, memory forensics dives deep into the volatile memory (RAM) of a system. This
approach is essential for uncovering evidence of malicious activity, such as active malware,
encryption keys, and transient data, that resides exclusively in memory and disappears upon
power-off. As cyberattacks grow more sophisticated, memory forensics has become an
indispensable tool for incident responders and forensic investigators alike.

At its core, memory forensics enables the extraction and analysis of system states during live
operations. This is critical for detecting advanced threats such as rootkits, process injection, and
fileless malware, which are specifically designed to avoid detection on storage media. By
capturing a snapshot of a system's memory, forensic analysts can reconstruct the events
leading up to a breach and identify suspicious activities that might otherwise leave no trace.
Tools like Volatility, Rekall, and modern commercial solutions have streamlined this process,
offering investigators powerful capabilities for examining volatile data across various operating
systems.

This comprehensive guide delves into the technical aspects of memory forensics, offering
insights into its methodologies, tools, and real-world applications. Whether you are an incident
responder, a malware analyst, or a digital forensics professional, this article provides a detailed
roadmap for leveraging memory forensics in combating modern cyber threats. From
understanding memory structures to employing cutting-edge tools and techniques, this guide
aims to equip readers with the knowledge required to excel in the field of volatile memory
analysis.

To be the vanguard of cybersecurity, Hadess envisions a world where digital assets are safeguarded from malicious actors. We strive to create a secure digital ecosystem, where
businesses and individuals can thrive with confidence, knowing that their data is protected. Through relentless innovation and unwavering dedication, we aim to establish Hadess as a
symbol of trust, resilience, and retribution in the fight against cyber threats.
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To be the vanguard of cybersecurity, Hadess envisions a world where digital assets are
safeguarded from malicious actors. We strive to create a secure digital ecosystem, where
businesses and individuals can thrive with confidence, knowing that their data is protected.
Through relentless innovation and unwavering dedication, we aim to establish Hadess as a
symbol of trust, resilience, and retribution in the fight against cyber threats.

At Hadess, our mission is twofold: to unleash the power of white hat hacking in punishing black
hat hackers and to fortify the digital defenses of our clients. We are committed to employing our
elite team of expert cybersecurity professionals to identify, neutralize, and bring to justice those
who seek to exploit vulnerabilities. Simultaneously, we provide comprehensive solutions and
services to protect our client's digital assets, ensuring their resilience against cyber attacks. With
an unwavering focus on integrity, innovation, and client satisfaction, we strive to be the guardian
of trust and security in the digital realm.

Security Researcher
Diyar Saadi
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EXECUTIVE SUMMARY

Memory forensics has become a critical component in modern
cybersecurity investigations, offering unparalleled insights into
system activity and volatile data. Unlike traditional disk forensics,
memory forensics focuses on capturing and analyzing the contents
of a system’s RAM to uncover evidence of active threats, such as
malware, rootkits, and encryption keys. This process is
instrumental in identifying sophisticated attack vectors, including
fileless malware and process injections, which often evade
traditional detection mechanisms. As cyber threats grow more
advanced, the demand for memory forensics expertise continues
to rise, making it a vital skill for incident responders and digital
forensic professionals.

This technical guide explores the key principles, methodologies,
and tools involved in memory forensics. From acquiring memory
images using tools like FTK Imager and Cellebrite to analyzing
volatile data with frameworks like Volatility and Rekall, the article
provides a step-by-step roadmap for mastering this specialized
domain. Additionally, it highlights practical applications, including
incident response, malware analysis, and threat hunting, while
addressing the challenges and best practices for effective memory
analysis. Whether investigating live incidents or reconstructing
post-breach scenarios, memory forensics is an indispensable
resource for staying ahead in the fight against cybercrime.
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Introduction to Memory Forensics

Memory forensics is a specialized field within digital forensics that involves the
analysis of a computer's volatile memory (RAM) to extract evidence of system
activity, running processes, network connections, and other crucial information
that is lost when a system is powered down. Unlike traditional disk forensics,
which focuses on analyzing static data stored on hard drives, memory forensics
targets dynamic data that exists temporarily in a computer's memory.
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Memory Structure
Process Structures
Structure Description  Location Forensic Analysis
Type Value Commands
_EPROCESS Process Kernel Process vol.py -f
Environment  Space details, mem. raw
Block threads, windows.pslist
handles
_PEB Process User DLLs, env vol.py -f
Environment  Space variables, mem. raw
Block cmdline windows.d11list
VAD Virtual Process Memory vol.py -f
Address Space mappings, mem. raw
Descriptor injected windows.vadinfo
code
Kernel Structures
Structure  Description Location Forensic Analysis
Type Value Commands
SSDT System Service Kernel Hooks, vol.py -f
Descriptor Space rootkit mem. raw
Table detection windows.ssdt
IDT Interrupt Kernel Interrupt vol.py -f
Descriptor Space handlers, mem. raw
Table hooks windows. idt
KPCR Processor Per CPU  CPU state, vol.py -f
Control Region thread info  mem. raw

windows. kpcr
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Memory Regions

Structure Description Location Forensic Analysis Commands

Type Value

Pool Kernel pool  System  Drivers, vol.py —f mem.raw

Memory allocations Space objects windows.poolscanner

Heap Process User Runtime vol.py —f mem.raw
heap Space data, windows. heaps
allocations strings

Stack Thread Thread Call vol.py —-f mem.raw
stacks Space traces, windows. threads

local vars

File Structures

Structure Description Location Forensic Analysis Commands

Type Value

_FILE_OBJECT File handle Kernel Open vol.py —f mem. raw
information  Space files, windows.handles

handles

_VACB Cache System  Cached vol.py -f mem.raw
management Space file data windows.cachedump

MFT Master File File File vol.py —f mem. raw

Table System metadata windows.mftparser
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Network Structures
Structure Type Description Location Forensic Analysis
Value Commands
_TCPT_OBJECT TCP Kernel Network vol.py -f
connections Space  connections mem.raw
windows.netscan
_UDP_ENDPOINT UDP Kernel Network vol.py -f
endpoints  Space listeners mem. raw
windows.netscan
_ETHREAD Network Process Connection vol.py -f
threads Space handlers mem. raw
windows.handles
Registry Structures
Structure Type  Description Location Forensic Analysis Commands
Value
_CM_KEY_BODY Registry Registry System vol.py —-f mem.raw
keys Space config, windows.registry.pri
autorun
_CM_KEY_VALUE Registry Registry Settings, vol.py -f mem.raw
values Space data windows.registry.dun
Hive Registry File Complete vol.py -f mem.raw
hive System  registry windows.hivelist

Common Memory Ranges

* User Space: 0x00000000 - Ox7FFFFFFF
* Kernel Space: 0x80000000 - OxFFFFFFFF
» System Space: 0xC0000000 - OxFFFFFFFF
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Definition and Importance of Memory Forensics
Definition

Memory forensics refers to the process of capturing and analyzing the contents
of a system's volatile memory (RAM) to uncover evidence of cybercrimes,
attacks, and other system activities. It allows investigators to view processes,
network connections, encryption keys, login credentials, malware, and other
hidden evidence that may not be stored on a hard disk.

Importance

1. Volatile Data Retrieval: RAM stores temporary information, such as active
processes, credentials, and data in use, that is lost once the machine is
powered off. Memory forensics allows investigators to capture this data
before it vanishes, which is critical for incident response and forensics.

2. Malware and Rootkit Detection: Memory forensics is especially useful for
identifying sophisticated malware and rootkits that may hide themselves in
memory to evade traditional disk-based detection methods.

- Network Traffic Analysis: It can help uncover network connections, open
ports, and even malicious network communication happening in real-time.

4. Encryption Key Recovery: Sometimes, critical encryption keys or
passwords are stored in memory, and memory forensics can help recover
them.

5. Live Evidence: Memory forensics often allows investigators to acquire
evidence while the system is still running, preventing the loss of crucial
information that might be overwritten during normal system operations.
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Key Differences Between Disk Forensics and

Memory Forensics

Aspect Disk Forensics

Focus of Examines data stored on
Analysis physical or logical disk

Data Volatility

Type of
Information
Retrieved

Investigation
Objectives

Tools and
Techniques

Challenges

Use Cases

drives (e.g., hard drives,
SSDs, USB drives).

MNon-volatile; data persists
after power-off.

Accesses files, deleted
data, partitions, metadata,
and logs.

Recovers files, determines
file access times, and
traces historical user
activity.

Tools include EnCase, FTK,
Autopsy, and Sleuth Kit for
static analysis.

Issues with encryption and
large data volumes.

Intellectual property theft,
fraud investigations, and
historical evidence
recovery.

Memory Forensics

Analyzes volatile data stored
in the system’s RAM.

Volatile; data is lost when the
system is powered down.

Retrieves active processes,
open network connections,
running applications,
encryption keys, and
malicious code.

Identifies malicious activities,
system state during
breaches, and live malware
evidence.

Tools like Volatility, Rekall,
and Memdump analyze
memory images and system
states.

Requires timely memory
capture and advanced
obfuscation technigues.

Incident response, malware
analysis, and live intrusion
detection.
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Volatility Essentials

Framework Architecture
The Volatility Framework is a powerful memory forensics tool designed to

analyze memory dumps. Its modular design allows extensibility through plugins,
enabling users to investigate a wide range of memory artifacts.

Installation and Configuration

Volatility can be installed on Windows, Linux, and macOS. It requires
dependencies like Python and memory profiles for effective analysis.

Cross-Platform Support

The framework supports memory dumps from various operating systems,
including Windows, Linux, and macQOS, offering versatility in cross-platform
investigations.

Plugin Ecosystem

Volatility's functionality is greatly enhanced by its ecosystem of plugins, which
specialize in tasks such as:

» Process Enumeration
* Registry Analysis
» Malware Detection
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Memory Profile Selection

Accurate memory profile selection ensures the framework can correctly
interpret the memory dump, matching it to the target system's kernel and
configurations.

vol.exe -f cridex.vmem imageinfo

»>wol.exe —F cridex.veem —profilesWinXPSPIxz86 pstree
¥y Framemork 2.6
Pid PPid Thds Hnds Time

ExB23cBch  Systen o -] 23 288 197Te-81-61 60:00:80 UTC+00ad
. BnBI2F1020:1nis. exe 168 ] 3 19 2812=-8T=22 B2 :42:31 UTC+BHad
FB2I9EToR : winlogon. exe 608 168 13 519 2912-9T-12 82:492:32 UTC+i0aa

. Bx8lelabld:services. exe 652 ] 16 243 2012-6T7-21 61:42:32 UTC+H000
ces. DMBEI1AFAED: Ivehost . exe 18546 652 5 58 2017=-8T=22 82:42:33 UTC+Hbad
a5« BNBleblThE: spoolsy.exe 1512 652 14 113 2812-6T-22 82:42:36 UTC+Dad
ces. BnBle29abd:svchost . exe a8 652 9 226 M12=8T7=22 82:42:33 UTC+HHad
won s DHBIIDOLGD: SVCROST . EXE logd 652 6 1118 2912-8T7-22 @2:42:33 UTC+B0aD
----- BB265bdat: muanclt . exe 135838 1684 > 132 20131-0T-11 B1:848:01 UTC+DGoo
..... B B2]Fodad: st exe 1138 1aadg a 173 2012=6T7=22 82:43:0& UTC+Hpad
eoss ONBIZ1LT6H: svChost.exe 824 [ 2 194 2812-9T-212 @2:492:33 UTC+Dddd
. BxBle8dad:aly.exe 788 652 7 184 1812-6T7-11 81:43:81 UTC+9Ead
eee . BNBIIVSESH:IvChost.exe 1228 £52 15 197 2812-87-22 82:492:35 UTC+odad
oo DmBle2adbl: lsass.exe il B8 id 330 2012-9T-22 B2:42:37 UTC+bad
GxBI2aB598  CESTSs. exe 584 168 @ 326 012-6T7-12 82:42:32 UTC+BEad
ExB821dea™; ¢xplorer.exe 198y Loy 17 H15 2813-67-22 B2:493:35 UTC+obaa8
. BBleThdal: reader_s1.exe 1648 Laag 5 19 2812=-8T=22 B2 :42:36 UTC+BDad

Core Investigation Plugins

Plugins such as pslist, psscan, and dlllist form the backbone of forensic
investigations. These tools provide detailed insights into:

« Active and hidden processes.
* Loaded libraries.
* Critical system components.
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Key Benefits:

|. Tracing Program Execution: Enables analysts to map the lifecycle of
processes and identify anomalies.

7. Uncovering Suspicious Activity: Helps detect hidden or malicious
processes.

\. Operational State Mapping: Provides a snapshot of the system's active
state for a comprehensive forensic analysis.

Example Command:

vol.exe —f cridex.vmem —profile=WinXPSP3x86 pslist

This command uses Volatility to analyze the memory dump ( cridex.vmem ) for
a system with the specified profile (WinXPSP3x86 ) and lists active processes
using the pslist plugin.

profils

WIAXPLIPIZES palist
Framewack 1.8

PID #PLD Thai L H] fedd  Wowdd Itart Enit

[ — R T - p— "

LS LEOD SEE . EE £ L 1 1% 0 SRRS-UT-2d W IHEE] UTCEDee
FEI2ENENE CEFEE . E0E o] e L b Fe L 0 SERI-UT-20 Qa3 R UTCE0a
BBl TIETO0 winlapen.eie Lo ] -] td] 5w ¥ 0 DOLE-0rT-X3 8 :ad: Rl UTCEoaa
FiBlddab2® FETYEORE . Hid BE L] 1% Ju} ¥ 0 SER2-IT-I] QDRI UFCE
PuBlelalnd laass, eue L] 2] I 1 # 0 2ULE-UT-13 B210F0NT UTCei
I BIRIL I wwchast, amw LR LEH £ i ¥ O DORZ-UT-TT BRcAT:RE UTC
PEELRdVaBE fwshIil. dae " B2 w 138 ¥ 0 2R2=UT=3] 202D EF UTC=0aeea
Pl SN0 FwohIsL . Eae O [ Lol 18 L 0 SRS B CHED R UTCEea0
LCRPRE L L B e ] FUE] Bl ] L2 L 0 SERI-UT-20 B2 IECRE UTCEi
PEEIIRSES0 FvThAT . EiE i B 1% LSy L 0 SER2-UT-2d Qe RE UTCE
PEElleeaT) EEplarer.€es Ludd auE 17 415 0 DLE-UT-X1 B2cadcBE UTCE
Pl eRlTHE Lpooliv, ene |11 F] [15%] 14 113 1 0 MOLT=UrT=13 8247 3& UTC=ddd
Ikl e Thdiuill resder_zl , eu ] s .1 ] i i ik PeirT- B0 1Y B UTC e
Enbipeldal alg wue T [15] T Lk ¥ B SRRT-UT-T3 B3 AN 01 UTC =0l
bl ¥cdal wesuclt saw k114 H [ | i | ¥ B L= B3 il i =il
Erhlalbdsh wesuclt. eue LAAN Lo 4 ¥ B JWLT=0T=T3 38801 UTC=0dad
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Advanced Memory Analysis Workflows

Advanced memory analysis workflows employ specialized techniques to
uncover hidden anomalies and stealthy threats. These workflows are designed
to:

* ldentify Suspicious Process Injections: Detect malicious code injected into
legitimate processes.

* Trace Memory-Resident Malware: Locate malware that resides only in
memory, avoiding disk-based detection methods.

* Detect Anomalously Mapped Memory Sections: Identify misaligned or
unusual memory mappings that could indicate malicious activities.

By systematically analyzing memory structures and behaviors, investigators can
reconstruct malicious activities and enhance their threat detection capabilities.

Custom Plugin Development

Volatility's open and flexible architecture enables investigators to develop
tailored plugins to address specific forensic needs, such as:

» Targeting specialized memory structures.
* Analyzing proprietary malware behaviors.
* Investigating unconventional data artifacts.

Benefits of Custom Plugin Development:

1. Extend Volatility's core functionality.
2. Adapt to evolving investigative challenges.
3. Focus on unique and specialized forensic requirements.
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Practical Memory Analysis Workflows

Identifying Malicious Processes
Using tools like pslist and pstree, investigators can:

. Enumerate and analyze processes running in memaory.
. Examine process hierarchies to identify anomalies.
. Detect discrepancies such as:
* Unusual parent-child relationships.
* Processes hiding under legitimate-looking names.
* Unknown or suspicious processes exhibiting abnormal behavior.

Example Workflow:
'.Run pslist:
D
vol.exe —f memory_dump.vmem --profile=Win75P1x64 pslist
Lists active processes for analysis.
2. Run pstree:
D

vol.exe =f memory_dump.vmem ——profile=sWin75P1x64 pstree

Displays hierarchical relationships among processes, helping to spot malicious
activity.
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*vol.exe =f cridex.vmem --profile=WinXP5PIxB6 pstree
y Framemork 2.6
Pid PPid Thds Hnds Time
0x823cB9ch:Systen u a 53 2uB 1976-81-61 06:08:00 UTC+O006
. BxB22€1820:smss.exe 368 L] 3 19 2012-87-22 82:42:31 UTC+B000
.« BxB22987T00 :winlogon.exe 508 368 23 519 2012-07-22 82:42:32 UTC+0E00
... GxBlelabi8:services.exe 652 668 16 243 2012-87-22 02:42:32 UTC+OE00
.. BxB2ldfdad:svchost.exe 1856 652 5 60 2012-87-22 6Z:42:33 UTC+B000
.. OxBleblTbE:spoolsv.exe 1512 652 14 113 2012-07-22 82:42:36 UTC+o000
.. OxBle29abl:svchost.exe a8 652 ] 226 2012-07-22 B82:42:33 UTC+B000
.. 8xB23001d0:svchost.exe 1864 652 64 1118 2012-87-22 82:42:33 UTC+DB80
.. BuB265bdat:muauclt.exe 1588  leed 5 132 2012-67-12 62:4d:01 UTC+o066
..... BxB21fcdad: muauclt . exe 1136  Llaeu ] 173 2012-87-12 @2:u3:u6 UTC+O080
vv.. OXB2311360:3vchost.exe a3y 652 20 194 28012-87-22 82:u2:33 UTC+0888
voa. OxBlOeBdab:alg.exe Te8 652 T 164 2012-67-12 62:u3:el UTC+aa0e
.. BxB2295650:svchost.exe 1228 652 15 197 2812-87-22 82:42:35 UTC+06080
««. BxBle2albd:lsass.exe G6d 688 au 330 2012-07-22 82:42:32 UTC+O000
.. Bx822a8598:csrss. exe 584 368 9 336 2012-07-22 82:42:32 UTC+0000
@x821deaTd  explorer.exe 1484 1aay 17 H15 2012-67-22 62:42:36 UTC+0880
. @x8leTbdad :reader_sl.exe 1648  L1dau 5 39 2012-07-22 02:42:36 UTC+O0E0

Investigation of Running Processes
Investigating running processes is a crucial step in memory forensics,

particularly when analyzing for potential malware, such as Cridex. This section
outlines the approach to identifying suspicious processes using Volatility.

Steps for Investigating Running Processes

1. Checking for Suspicious Process Names

Malware often disguises itself under legitimate-sounding process names. A
detailed inspection of the process list can help uncover anomalies.

2. Checking for Processes with Different Parent Process
IDs (PPID)

Processes with unexpected or unusual parent process IDs can indicate
tampering or injection by malicious actors. Analyzing the PPID relationships
provides critical clues.

Case Example: Identifying reader_sl.exe

In this investigation, the malware is disguised under the process name
reader_sl.exe.
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Command for Analysis

To inspect the running processes and identify suspicious entries like
reader_s1.exe, use the following Volatility command:

vol.exe -f cridex.vmem ——profile=WinXPSP3x86 pslist

~=f cridex.vmem: Specifies the memory dump file to analyze.
——profile=WinXP5P3x86 : Defines the memory profile matching the target
system (Windows XP SP3 x886).

pslist: Lists all running processes and their parent-child relationships.

iy & & & & & & &
X | 1 |

While selecting the suspicious process name we will have to know what is the
process functionality in addition what is the purpose of this suspicious process .

What is Reader_sl.exe?
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Based on the search, it is suspected that the infected host machine may
have been compromised by malicious documents, such as .pdf or .docx.

Tracing the Creator of reader_sl.exe

Another plugin from Volatility, pstree, can be used to identify which process or
program created reader_s1.exe . This analysis can provide additional
indicators for investigation.

o
vol.exe —f cridex.vmem —profile=WinXPSP3x86 pstree

suser T \Downloads\vol>vol . exe —F cridex.vees —profilesWindPSPIxes pstree
‘olatility Foundation Volatility Framework 1.6

lane Pid PPid Thds Hnds Tiee
BB TcB9CE : Systea L] /] 53 260 1970-01-01 B8 :00: M UTC+DoN
BxBX2F1828: snii.exe g q 3 19 2812-07=-23 82:42:31 UTC+Doda
. BxBI298TE9:winlogon. exe 688 368 13 519 117-07-11 82:497:32 UTC+Boa8
. BxBlelablEservices.exe 652 [ 16 243 X12-0T=-12 82:41:32 UTC+Dddd
.. OuBlldfdaid:svchoit.exe l1as4 652 5 58 2012=0T=22F 82:42:33 UTC+Dodd
e B:i&ltbl'?b&:ipﬁn'li'i'.l'l:t 1512 552 1= 113 2812-07-13 82 :87:36 UTC+D000
sus @mBleZPabd:svchost.exe 05 652 ] 226 2012-0T7-22 92:41:33 UTC+Dodd
v GEETIMO100: SVIROST. EXE leea 652 2] 1118 2012-07-22 82:82:33 UTC+O00
oo DEEIOSHAND : BEAUELY . EXE 1588 1@ -1 137 X12-0T=22 B2:84:01 UTC+DaD
e BuAI1FCdad  muauclt . exe 1138 1E6 B 173 2812-87=1F 82 :03:08 UTC+0008
v oo BEBZILLIE0:sVChOST.0me 814 653 I8 199 T812-07-11 82:497:33 UTC+Boa8
. DuBlieBdad:alg.exe Ta8 652 T 109 X12-0T=-212 B2:43:01 UTC+DddD
o .. OuBXIOSES5H:svchoit . exe 1238 652 15 197 X12=-0T=32 82:42:315 UTC+DodD
.- BEBleladb8:LEass.exe 664 &BE Ll 339 111-07-11 B81:81:32 UTC+DooE
e 12 ¥ 326 M012-0T7-1T 82:41:32 UTC+Dodd
lqsq 1adg 17 415 M12=-0T=22 B82:40:36 UTC+Dddd
1&88 1384 -] 32 MR12-07-11 8218236 UTC+0008

Analysis Using pstree Plugin

Based on the details provided by the pstree plugin, we have a clue that
explorer.exe is creating reader_sl.exe. This potentially indicates that the
infected host machine opened malicious documents, such as those received
from an attacker.
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Investigating a Process's Internet Connection

Investigating a process's internet connection in memory forensics is crucial for
identifying potential malicious activities, such as communication with
Command and Control (C&C) servers.

vol.exe -f cridex.vmem —profile=WinXP5P3x86 connscan

wol.exe —F cridex.veea —profile=WiniPSPIx86 connscan

208T7E29 172.16.112.128:1838 4], 168 5. 108:8888
13aB008 172.16.112.128:1837 125.19.183. 193 : 8080

Users\ardlyarr\Domnloads\wal>

Processes with Remote Connections

During the analysis, two processes were identified as having made a connection
to remote addresses:

|. explorer.exe
Suspected process: reader_sl.exe

Logical Analysis

A logical question arises: Why should reader_sl.exe establish an internet
connection?

To further investigate, it is essential to check the remote IP address associated
with this connection on VirusTotal or similar threat intelligence platforms for
potential malicious activity.
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* Parent Process ID (PPID): 1484 (Thisis the PPID for reader_sl.exe.)



|
HADESS.IO Memory Forensics: A Comprehensive Technical Guide

Advanced Memory Forensics Techniques

A.Process and Thread Analysis

1. Process Tree Reconstruction

* This technique involves mapping the parent-child relationships
between processes in memory to detect anomalies in the process
hierarchy.

* By reconstructing the full process tree, investigators can identify
abnormal or unexpected relationships, such as hidden processes
masquerading under legitimate ones, which could indicate the
presence of malware.

2. Hidden and Injected Process Detection

* Tools such as psscan and malfind are essential for identifying
stealthy processes or those injected into legitimate ones.

* These processes may not appear in standard process enumeration
tools but can be detected by scanning memory for:

* Suspicious code patterns
* Altered process structures
* Injected payloads
= Such findings often point to malicious activities.
3. Thread State Examination

* Analyzing thread activity is critical for uncovering potential malicious
actions. Investigators should focus on:
* Threads with unusual priorities
* Abnormal execution states
« Suspicious starting addresses

* Malicious threads may attempt to hijack legitimate processes or exploit
system resources for nefarious purposes.



L
HADESS.IO

Memory Forensics: A Comprehensive Technical Guide

1. Kernel-mode Thread Analysis

* Investigating threads running in kernel mode is crucial, as they may
signal the presence of rootkits or OS-level compromises.
* Rootkits often:
* Operate at the kernel level to conceal activities.
« Exhibit suspicious characteristics, such as hiding from user-mode
monitoring tools.
* Interact directly with the OS kernel to evade detection.

B. Investigating Timeline

* The timeliner plugin in Volatility is used to create a timeline of events
based on timestamps extracted from various artifacts in the memory image.
* This timeline is invaluable for understanding the sequence of actions on a
system, particularly during:
* Incident response
* Forensic investigations

1. Normal Use:

m|
vol.exe —f cridex.vmem —profile=WinXPSP3x86 timeliner
2. Pipe Output to a Text File:

D

vol.exe —-f cridex.vmem —profile=WinXPS5P3x86 timeliner >
timeline.txt
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Investigation: Clipboard Hooking

The wndscan plugin in Volatility is utilized to scan for window objects in
memory.

This functionality is particularly useful for identifying both visible and
hidden windows created by processes, which may include:

Malware-related activity

Suspicious behavior

Normal Use:

n
vol.exe —-f cridex.vmem —profile=WinXPSP3x86 wndscan

Pipe Output to a Text File:

D
vol.exe —f cridex.vmem —profile=WinXPSP3x86 wndscan > wnd.txt
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Checking for Files: filescan Plugin

* The filescan plugin in Volatility is used to identify file objects in memory
that may not have been mapped to disk.
* This is particularly useful for detecting hidden or injected files that could be
used by malware.

vol.exe -f cridex.vmem —profile=WinXPSP3x86 filescan
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Note : regarding to your time . we can use | findstr in windows or | grep in Linux
to search for specific file on this

ol.exe =F cridex.vmem =-profile=WinXP5SPIxBE Filescan | findstr *.exe*
Framewmor¥ 1.6
@ R-—rmd \Device\HarddiskVolumel\WINDOWSYexplorer.exe
BeaRR080082036d28 1 @ R——rwd \Device\HarddiskVolumel\WINDOWS\system32\nthrnlpa. exe
BE00BEEEET036F28 1 8 R=—red \Device\HarddiskVolumel\WINDOWS\system32\ntoskrnl.exe
GE0RREEEI6T Fdad 1 8 R——red \Device\HarddiskVolumel\WINDOWS\system32\ logonui.exe
0000000002081 90 1 @ R—rwd \Device\HarddiskVolumel\WINDOWS\system32\lsass.exe
009000800209FdF8 1 @ R——rwd \Device\HarddiskVolumel\WINDOWS\system32\verclsid. exe
GE90aea820053F0 1 @ R-——rad \Device\HarddiskVolumsel\WINDOWS\system32\spider.exe
0040000002005600 1 8 R—rud \Device\HarddiskVolumel\WINDDWS\system32\mshearts.exe
GEa0H0E88 2005308 1 8 R=—rwd ‘\Device\HarddiskVolusel\WINDOWS\system32\Restore\rstrul. exe
B8400088820c3cT0 1 8 R=-rad \Device\HarddiskVolusel\WINDOWS\system32\userinit. exe
8890688882 2cUShE 1 8 R==rad \Device'\HarddiskVolumel\WINDOWS\system32\autochk. exe
000000802 3IUShdd 1 @ R=—rwd \Device\HarddiskVolumel\WINDOWS\system32\rundLl32. exe
000000002 3Ubabe 1 @ R—rwd \Device\HarddiskVolumel\WINDOWS\system3d\services. exe
B800660888238c778 1 @ R—rwd \Device\HarddiskVolumel\Documents and Settings‘Robert‘\Application Data\KBEGIOTETT.exe
GE90REEE82 adals 1 8 R——rwd \Device\HarddiskVolumel\WINDOWS\system32\winlogon.exe
G00006808023b8380 1 @ R—rwd \Device\HarddiskVolumel\WINDOWS\system3d\lsass.exe
0840068882 3c6eTE 1 @ R=—rwd \Device\HarddiskVolusel\WINDOWS\system32\ logonui. exe.manifest
Bea0QREae23ccFI0 1 @ R=—rwd \Device\Harddiskvolusel\Program Files\Adobe\Reader 9.0\Reader\reader_sl.exe
BeanH0e0023d1bEE 1 8 R=—r-d \Device\HarddiskVolusel\WINDOWS\system32\wuauclt.exe
0000000002 TduFad 1 8 R=—rwd ‘\Device\HarddiskVolumel\WINDOWS\system3d\csrss, exe
2000008002 34dT60 1 8 R==ru= ‘\Device\HarddiskVolumel\WINDOWS\explorer. exe
4 — = Harddiskvolumel\Documents and Settings\RoberthApplication Data\KBOO2OTETT exe

Checking for Malware: malfind Plugin

* The malfind plugin in Volatility is a powerful tool for identifying potential
malware within a memory dump.

* It scans for injected code or anomalous memory sections that are typically
associated with malware.

m)

vol.exe —f cridex.vmem ——profile=WinXPSP3x86 malfind
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‘rocess: reader_sl.exe Pid: 1648 Address: @x3désea
fad Tag: Vads Protection: PAGE_EXECUTE_READWRITE
‘lags: CommitCharge: 33, HemCommit: 1, PrivateMemory: 1, Protectien: &

66308680 ud S5a 90 B0 03 6O 00 00 OU 00 60 68 Ff FF B0 B8 MI..............
inBo3dole b3S 00 00 B0 00 00 00 00 4D OO0 00 0O 00 0D B0 BB ........ Wiasiass
ixnBe3de620 60 00 60 00 00 60 00 00 00 0D 60 00 BO B0 B8O B8 ................
JxBo3doe3e o0 00 00 B0 0O 0O 0O 0D 0D OO B0 0D o0 BB BB BB ................

xge3dagas ud DEC EBP
IxB83deesl Sa POP EDX
Be3daaal e NOR

08340683 0603 aDD [EBX], AL
xBe3datas e ADD [EAX], AL
Ix003de68T 0eadan ADD [EAX+EAX], AL
ixBe3datoa G088 ADD [EAX], AL
Ixee3daaac £ DB Oxf¥
inBg3dogad ffog IKC DWORD [EAX]
8830868+ GEDERBEEGREE ADD [EAx+@xe], BM
xBe3deals oeaa ADD [EAX], AL
003dedlT cedobo ADD [EAX+8x8], AL
xge3deala e000 ADD [EAX], AL
nBa3dedle GBEG ADD [EAX], AL
x883deale 0600 ADD [EAX], AL
1e63dee2e Be8e ADD [EAX], AL
Ix883d8622 0608 ADD [EAX], AL
nBe3deaiy oeag ADD [EAX], AL
IxB83de826 0608 ADD [EAx], AL
nBe3doais opoa ADD [EAX], AL
Ix083d062a 0600 ADD [EAX], AL
xBe3dedic B0a8 ADD [EAX], AL
Ix083deeze 0600 ADD [EAX], AL
IXBE3dea3n BE89 ADD [EAX], AL
08348032 0600 ADD [EAX], AL
1x863d8e3Y BEES ADD [EAX], AL
08348036 00600 ADD [EAX], AL
xBe3doa3s ooaa ADD [EAX], AL
Ix083dee3a 0088 ADD [EAX], AL
xB83de83c ebbd LOOPNZ Bx3doe3e
1x083d003e 0080 ADD [EAX], AL

C.Memory Artifact Reconstruction

* Registry Hive Recovery: Extracting and analyzing registry hives from
memory to uncover configuration changes or malware persistence
mechanisms.

* Network Connection Tracking: Identifying live or historical network
connections to analyze potential data exfiltration or communication with
command-and-control (C2) servers.

= Authentication Session Forensics: Investigating authentication tokens,
session IDs, and user credential usage stored in memory.

» Cached Credentials Examination: Analyzing cached credentials to detect
potential credential harvesting or misuse.
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Specialized Memory Forensics Domains

A. Rootkit and Stealth Malware Detection

* Kernel-mode Rootkit Identification: Uncovering rootkits that operate at the
kernel level by analyzing kernel memory and system structures.

* Hooking Mechanism Detection: Detecting modifications to system call
tables, inline hooks, or API hijacking techniques used by malware.

* Memory-based Rootkit Analysis: Analyzing memory structures to identify
hidden drivers, kernel modules, or other malicious artifacts.

* Anti-forensic Technique Identification: Spotting attempts by malware to
evade detection, such as memory wiping or data encryption.

B. Tools and Ecosystem
A. Complementary Memory Forensics Tools

* Rekall Framework: An alternative to Volatility with similar capabilities,
focusing on live memory analysis and performance optimization.**

* FTK Imager: A tool for creating and analyzing forensic images, including
memory dumps.**

* WindowsSCOPE: A commercial solution offering visualization and detailed
memory analysis capabilities.**

* Memory Analysis Script Collections: Scripts designed to automate
repetitive tasks in memory analysis, streamlining the forensic workflow.**
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Enhanced Cellebrite Memory Acquisition

Category Action Steps Real-World Notes
Example
Tool Cellebrite Use Cellebrite  Extract data Ensure
UFED UFED Touch 2 from an compatibility
or UFED 4PC  iPhone 12 with device
to start the with i0OS 15 OS version.
extraction. during a
criminal
investigation.
Device Supported  Check Verified that Regularly
Compatibility Devices supported Android 11 on  update the
devices and a Samsung Cellebrite
OS versions Galaxy S21is  tool for new
on Cellebrite's supported. devices.
website or
tool interface.
Physical Full Physical - Connect Extracted Ideal for
Extraction Extraction device to complete older
UFED. memory devices or
- Select image from an unlocked
"Physical unencrypted  ones.
Extraction” iPhone SE
mode. (2020).
- Authenticate
access (if
needed).
Logical Logical - Connect Retrieved Requires
Extraction Extraction device. WhatsApp device to be
- Select chat logs unlocked or
"Logical fromalocked user-
Extraction". Android provided
- Acquire app  device. credentials.
and file

system data.
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Enhanced FTK Imager Memory Acquisition

Memory Capture

Action Steps/Commands Notes

Live Memory 1. Navigateto File >  CPU usage may spike during
Capture Memory capture.
2. Select the
destination
3. Specify the filename

Pagefile 1.Goto File > Add Typically located at
Evidence Item %SystemRoot%\pagefile.sys.
2. Select Physical
Drive
3. Locate and select
pagefile.sys

Hibernation 1.Goto File > Add Found at
File Evidence Item %SystemRoot%\hiberfil.sys.
2. Select Physical
Drive
3. Locate and select
hiberfil.sys
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Evidence Acquisition

Action Steps/Commands MNotes
Physical Memory 1. Select the source device Outputs a .mem file
2. Navigateto Create Image for analysis.
> Memory
Memory Image 1. Goto Tools = Verify Ensures data integrity.
Verification Drive/Image
2. Select the source
3. Compare the hash
(MD5/SHA1)
Write Blocking Enable "Write Block" option Prevents source
before capture. modification.
Analysis Features
Feature Steps/Commands Notes
File 1. In the Evidence Tree, explore Preserves metadata during
Recovery the content export.
2. Right-click and select
Export Files
String 1. Navigate to Tools > Text Supports regular
Search Search expressions (regex).
2. Enter keywords
Hex View 1. Select a file or sector Displays raw data in

2.Goto View > Hex hexadecimal format.
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Memory Artifacts
Artifact Steps/Commands Notes
Process List Navigate to View > Program Displays active
List running processes.
Network Navigate to Tools > Network Shows active network
Connections Status connections.
Registry Hives  Navigate to Extracts system
\Windows\System32\config configuration settings.
Export Options
Format Menu Path Use Case

RAW (dd) Export > RAW  Universal compatibility across tools.
EO1 Export > E@1 EnCase forensic container format.
AFF4 Export > AFF4 Advanced forensic format for scalability.
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Enhanced Volatile Memory Acquisition
Real-time Memory Streaming

* Implement continuous memory capture techniques that allow for real-time
streaming of volatile memory

* Develop mechanisms to detect and capture memory changes as they occur
* Use memory diffing to identify significant changes between captures

Hardware-Assisted Acquisition

* Leverage Intel Processor Trace (PT) for detailed execution tracking
* Implement Direct Memory Access (DMA) acquisition techniques

« Utilize modern CPU features like AMD's Secure Memory Encryption (SME)
for trusted acquisition

Modern Memory Acquisition Tools

LiME (Linux Memory Extractor)

# Install LiME on Linux

git clone https://github.com/504ensicsLabs/LiME
cd LiME/src
make

# Capture memory

sudo insmod lime-<version>.ko "path=/tmp/memory.lime
format=1ime"
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WinPMEM (Windows)

# Capture full memory dump
winpmem_mini_x64_rc2.exe memory.raw

# Capture with compression
winpmem_mini_x64_rc2.exe —C memory.raw

Advanced Analysis Techniques

Machine Learning Integration

* Deploy supervised learning models to detect anomalous process behaviors

* Implement clustering algorithms to identify groups of related malicious
activities

* Use deep learning for pattern recognition in memory structures
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import tensorflow as tf

class MemoryAnomalyDetector:
def __init__ (self):
self.model = tf.keras.Sequential([
tf.keras.layers.Dense(128, activation='relu'),
tf.keras.layers.Dropout(0.2),
tf.keras.layers.Dense(64, activation='relu'),
tf.keras.layers.Dense(1, activation="sigmoid")

1)

def train(self, memory_features, labels):
self.model.compile(optimizer="adam’,
loss="'binary_crossentropy’,
metrics=['accuracy'])

return self.model.fit(memory_features, labels,
epochs=10,
validation_split=0.2)

Container and Cloud Memory Analysis

Container Memory Forensics

+ Develop specialized tools for analyzing container runtime memory

* Implement techniques for correlating container memory with host system
memory

* Create methods for analyzing container escape attempts
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Docker Memory Analysis

# Capture Docker container memory
docker-forensics -c container_id -o output_dir

# Analysis script
python3 analyze_container_memory.py
output_dir/container_memory.raw

# Container memory analysis implementation
class DockerMemoryAnalyzer:
def __init_ (self, memory_dump):
self.memory_dump = memory_dump

def analyze_container_escape(self):
# Check for privileged operations
privileged_ops = self._scan_privileged_operations()

# Check for mounted sensitive paths
mount_violations = self._check_mount_violations()

# Check for capability abuse
capability_abuse = self._detect_capability_abuse()

return {
‘privileged_ops': privileged_ops,
‘mount_violations': mount_violations,
‘capability_abuse': capability_abuse

Cloud-Native Memory Analysis

* Implement techniques for analyzing memory across distributed systems
* Develop tools for analyzing serverless function memory states
* Create methods for correlating memory artifacts across cloud services
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Advanced Malware Detection

Polymorphic Malware Detection

* Implement behavior-based detection methods
- Develop techniques for identifying code mutation patterns in memory
* Create methods for tracking malware evolution across memory snapshots

Advanced Rootkit Detection

* Implement kernel integrity verification mechanisms
* Develop methods for detecting advanced hooking techniques
* Create tools for identifying sophisticated privilege escalation attempts
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Volatility 3 with Custom Plugins

Python
# Custom plugin for encrypted process detection

import yara
from volatility3.framework import interfaces

class

EncryptedProcessDetector(interfaces.plugins.PluginInterface):
_required_framework_version = (2, @, @)

def run(self):
# Load YARA rules for encryption detection
rules = yara.compile(source="'""
rule EncryptionIndicators {

strings:
$aes = {67 74 71 6E 28 73 76 71}
$rsa = {82 65 78 61 2D 70 75 62}
condition:
any of them
}
LI I | }
# Scan Ii': rocess memo J
for proc in self.context.processes:
matches =

rules.match(data=proc.get_process_memory())
if matches:
yield (@, (proc.UniqueProcessld,
proc.ImageFileName.cast("string"),
"Encryption Detected"))
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Memory Forensics Automation

Layer

1. Acquisition

2. Initial Triage

3. Al Detection

4. Process Analysis

5. Network Analysis

6. Malware Scanning

7. Memory Mapping

8. Artifact Extraction

9. Timeline Analysis

10. Reporting

11. Continuous Monitoring

Purpose Tools

Memory Capture - LIME (Linux)
- WinPmem
= Dumplt
- FTK Imager

Quick Analysis - Volatility3
- Rekall
- bulk_extractor

Pattern Recognition - TensorFlow
- scikit-learn
- YARA

Deep Inspection - Volatility Plugins
- Custom Scripts
- ProcessHacker

Connection Review - NetworkMiner
- Wireshark
- Volatility netscan

Threat Detection - ClamAv
- YARA Rules
- VirusTotal API

Structure Analysis - VolShell
- WinDbg
- GDB

Data Recovery - Photorec
- Foremost
- Volatility DumpFiles

Event Correlation - log2timeline
- Plaso
- Timesketch

Documentation - ElasticSearch
- Kibana
- Custom Templates

Real-time Analysis - Sysmon

- OSQuery
- EDR Solutions
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Automated Analysis Pipeline

* Implement automated triage systems for memory dumps
 Develop intelligent filtering mechanisms for relevant artifacts
* Create automated reporting systems

Continuous Monitoring

* Implement real-time memory monitoring systems
* Develop automated alert mechanisms for suspicious memory activities
* Create systems for continuous baseline comparison
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class MemoryForensicsPipeline:
def __init_ (self):
self.volatility = VolatilityInterface()
self.yara_scanner = YaraScanner()
self.ml_detector = MemoryAnomalyDetector()

def analyze_memory_dump(self, dump_path):
# Stage 1: Initial triage
profile = self.volatility. identify_profile(dump_path)
processes = self.volatility.get_processes(dump_path,
profile)

# Stage 2: Deep analysis
suspicious_processes = []
for process in processes:
score = self._analyze_process(process)
if score > THRESHOLD:
suspicious_processes.append(process)

I LA

& L4 A T " =3 Y m
¥ Stage 3: Advanced detectio

malwafe_detectinn = self.yara_scanner.scan(dump_path)
anomaly_detection = self.ml_detector.analyze(dump_path)

# Stage 4: Report generation
return self._generate_report(
suspicious_processes,

malware_detection,
anomaly_detection
)

def _analyze_process(self, process):
return {

'pid': process.pid,

'name': process.name,

'memory_regions':
self._analyze_memory_regions(process),

'network_connections':
self._analyze_network(process),

'handles': self._analyze_handles(process),

"threads': self._analyze_threads(process)



~ Conclusion

In conclusion, memory forensics is a vital pillar of modern digital investigations, offering unique
insights into the volatile data that underpins system activity. By capturing and analyzing memory,
investigators can uncover critical evidence of advanced threats, including malware, unauthorized
access, and system misconfigurations that evade traditional forensic methods. This guide has
highlighted the essential tools, techniques, and best practices necessary to excel in this field,
underscoring its importance in incident response, malware analysis, and proactive threat hunting.
As cyber threats evolve, mastering memory forensics equips professionals with the expertise
needed to detect, analyze, and mitigate even the most sophisticated attacks, ensuring robust
system security and resilience.
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